
SECURE CONNECTOR FOR 
MICROSOFT OFFICE 4.7

Installation and Setup Guide 

Copyright © CyberVault Solutions Inc., 2022. All Rights Reserved. www.CyberVault.com



1. Introduction.............................................................................................................................................................................................................................4

2. Install Secure Connector for Microsoft Office on a Client Computer........................................................................................................................5
     2.1. Overview..................................................................................................................................................................................................................5
     2.2 Installation Checklist.............................................................................................................................................................................................5
     2.3.      Before You Install...................................................................................................................................................................................................6

2.3.1.  Check the Prerequisites............................................................................................................................................................................6

2.3.2   Uninstall Previous Versions of the Outlook Add-in 3.x....................................................................................................................7

2.3.3.  Download the Installation Package for Secure Connector for Microsoft Office........................................................................7
     2.4. Install Secure Connector for Microsoft Office.......................................................................................................................................................7

2.4.1.   Standard Installation................................................................................................................................................................................7

2.4.2.   Installation Using Advanced Installation Options............................................................................................................................8

3. Configure Secure Connector for Microsoft Outlook....................................................................................................................................................9
 3.1.    Configure Data Room Servers...............................................................................................................................................................................9

     3.2.    Adjust the General Settings for Secure Connector for Microsoft Outlook...............................................................................................10

3.2.1. Adjust the Language Setting..................................................................................................................................................................10

3.2.2. Adjust the Email Options........................................................................................................................................................................10

3.2.3. Adjust the Protected Message Options...............................................................................................................................................11

3.2.4. Adjust the Document Upload Options................................................................................................................................................11

3.2.5 Adjust the Document Download Options............................................................................................................................................11
3.2.6. Adjust the Debug options / Send a Log File to Support.................................................................................................................11

    3.2.6.1.    Locate Other Log Files For Suport............................................................................................................................................12

3.3. Adjust the Attachment Handling Settings for Secure Connector.........................................................................................................................12

 3.3.1.    Adjust the Settings to Convert Attachments into Links..............................................................................................................................12

     3.3.2.   Adjust the Auto-Upload and Link Insertion Setting.....................................................................................................................................13

3.4. Adjust the Server Settings for Secure Connector for Microsoft Outlook...........................................................................................................13

     3.4.1.   Add Data Room Servers.....................................................................................................................................................................................13

     3.4.2.  Change Data Room Servers...............................................................................................................................................................................14

     3.4.3.  Remove Data Room Servers..............................................................................................................................................................................14

     3.4.4.  Adjust the Proxy Server Settings.......................................................................................................................................................................14

3.5. Adjust the Sync Settings for Collaboration Items for Secure Connector............................................................................................................15
     3.5.1.  Adjust the Sync Settings for Data Room Collaboration Items....................................................................................................................15
     3.5.2. Adjust the Sync Settings for Data Room Calendar Events...........................................................................................................................15
     3.5.3. Adjust the Sync Settings for Data Room Tasks................................................................................................................................................16
3.6. Check for Updates...........................................................................................................................................................................................................16

3.6.1.  Automatic Update of Secure Connector for Microsoft Outlook..................................................................................................16

          3.6.1.1.  Automatic Update of Secure Connector for Microsoft Outlook...................................................................................16

3.6.2.  Manual Update of Secure Connector for Microsoft Outlook.......................................................................................................16

4. Configure Secure Connector for Microsoft Excel, Word, or PowerPoint Documents.........................................................................................18
4.1. Configure Data Room Servers..........................................................................................................................................................................18

     4.2. Adjust the General Settings for Secure Connector......................................................................................................................................18

Contents

Secure Connector for Microsoft Office 4.7 | Installation and Setup Guide  Page 2 of 22



4.2.1.  Adjust the Download Options for Excel, Word, or PowerPoint Documents..............................................................................18
     4.3.      Check for Updates...............................................................................................................................................................................................19

4.3.1.  Automatic Update of Secure Connector............................................................................................................................................19

      4.3.1.1.  Adjust the Automatic Update Settings.....................................................................................................................................19 

4.3.2. Manual Update of Secure Connector.............................  ...................................................................................................................19

5. Frequently Asked Questions.............................................................................................................................................................................................21
     5.1. What is contained in the installation package?............................................................................................................................................21
     5.2. What do I do if the installation has failed for some reason?.....................................................................................................................21
     5.3.      What can I do if Secure Connector for Microsoft Office is deactivated accidentally or does not show up after the 

installation?............................................................................................................................................................................................................21
     5.4.      AVG Virus Protection prevents Installation and Reports an “Identity Protection” Problem. How can I still install?....................22
     5.5.      Secure Connector does not install with Microsoft Office 2007................................................................................................................22

Secure Connector for Microsoft Office 4.7 | Installation and Setup Guide       Page 3 of 22 



1. Introduction

Secure Connector for Microsoft Office is a client-based software program that seamlessly integrates 
Microsoft Outlook, Excel, Word, and PowerPoint with the CyberVault Secure Data Room. 

The service provided by Secure Connector for Microsoft Outlook goes far beyond a very comfortable way 
of sending emails and email attachments securely as document links. It allows the user to navigate in, 
upload to and download from a Data Room.

Secure Connectors for Microsoft Excel, Word, and PowerPoint are fully integrated Excel, Word, and 
PowerPoint add-in clients that allow Data Room users to download their Microsoft Office documents from 
their Data Rooms into Excel, Word, or PowerPoint, respectively. Users can then edit their documents in the 
respective Microsoft Office application and can easily re-upload the updated documents to the Data Room. 
Secure Connectors for Microsoft Excel, Word, and PowerPoint also allow for using the Data Room Check-out 
and Check-in functions for documents, and for creating tasks on Microsoft Office documents.

The present installation guide is intended for system administrators or others who install Secure Connector 
for Microsoft Office on a client computer.

Secure Connector for Microsoft Office 4.7 | Installation and Setup Guide        Page 4 of 22 



2. Install Secure Connector for
Microsoft Office on a Client Computer

2.1. OVERVIEW

To help you with the installation process, we suggest that you print out the installation checklist below on 
installing so that you can refer to it as you move through the installation process.  

The installation of Secure Connector for Microsoft Office on a client computer is done through an install-
er executable file named “Secure Connector for Microsoft Office.exe”, which can be downloaded from the 
CyberVault download site (see section 2.3.3). The executable file is a full installation package that contains 

all 
required software components. 

The installation of Secure Connector for Microsoft Office is easy. For questions and troubleshooting, see 
section 5 Frequently Asked Questions as of page 31. 

The present installation guide is intended for system administrators or others who install and Secure 
Connector for Microsoft Office on a client computer.

2.1. INSTALLATION CHECKLIST

Before you start to install Secure Connector for Microsoft Office, review the following task checklist. 
> Read section 2.3 Before You Install, and follow the instructions in that section to ensure that your

computer is set up properly for the installation, that is:

• Check the minimum system requirements necessary to install Secure Connector for
Microsoft Office.

• Download the installation package for Secure Connector for Microsoft Office from
our download site. The executable file is a full installation package that contains all required
software components.

• Save this file to a location on your computer where you can find it, e.g. your desktop.

> Run the installer executable to install the software on your computer.

> Once you have installed the software, proceed to section 3 Configure Secure Connector for
Microsoft Outlook, page 16.
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2.3. BEFORE YOU INSTALL

2.3.1 CHECK THE PREREQUISITES

Secure Connector for Microsoft Office requires the following 

prerequisites:

> Permission to install software on the respective client computer:
Users must have the permission to install software on their client computers or an administrative
user must install the software for the user on their client computer.

> Client computer with one of these supported operating systems:

• Windows 10 (32-bit and 64-bit), Windows Server 2012 R2 (32-bit and 64-bit)
• Windows 8.1 (32-bit and 64-bit), Windows Server 2012 (32-bit and 64-bit)
• Windows 7 (32-bit and 64-bit), Windows Server 2008 R2 (32-bit and 64-bit)

> Client computer with one of these Microsoft Office suites including Microsoft Outlook, Excel, Word,
and PowerPoint:

• Microsoft Office 2007 SP3 (32-bit only) – see Frequently Asked Questions, page 33
• Microsoft Office 2010 (32-bit only)
• Microsoft Office 2013 (32-bit only)
• Microsoft Office 2016 (32-bit only)

> Client computer with these software components:
Note that all required software components are included in the installation package (executable file),
and therefore do not need to be installed separately. These components are:

• Microsoft .Net 4.5.2 Framework or newer
• Microsoft Visual Studio 2010 Tools for Office Runtime (x86) for 32-bit systems
• Microsoft Visual Studio 2010 Tools for Office Runtime (x64) for 64-bit systems
• Microsoft Visual C++ 2012 Redistributable (x86) – 11.0.610.30
• Optional: Microsoft Visual C++ 2012 Redistributable (x64) – 11.0.610.30

> Secure Data Room:

• Version 8.20.031 or newer for authentication to a Data Room through input of the username
(email address) and password

• Version 8.20.601 or newer for authentication to a Data Room through SAML
• Version 8.30.701 or newer for authentication to a Data Room through SAML protocol 2.0
• Each Data Room that you want to work with must have web services (API Access) enabled.

Please contact your Data Room (Center) Manager if you have any questions about this.
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2.3.2. UNINSTALL PREVIOUS VERSIONS OF THE OUTLOOK ADD-IN 3.X

If you have been using a previous 3.x version of the Outlook Add-in, you must uninstall this version 
first.
1. Click the Windows Start Button.
2. Point to Control Panel and select Programs and Features.
3. Right-click the Outlook Add-in program and click Uninstall.

2.3.3. DOWNLOAD THE INSTALLATION PACKAGE FOR SECURE CONNECTOR FOR 
MICROSOFT OFFICE

The installation of Secure Connector for Microsoft Office on a client computer is done through an 
executable file named “Secure Connector for Microsoft Office.exe”, which can be downloaded from the 
CyberVault download site. The executable file is a full installation package that contains all required 
software 
components.
> Download the latest EXE installer file.
> Save this file to a place where you can find it, e.g. on your Windows 

Desktop.
2.4. INSTALL SECURE CONNECTOR FOR MICROSOFT OFFICE 

2.4.1. STANDARD INSTALLATION

1. Close all Microsoft Office applications.
2. Double-click the “CyberVault Secure Connector for Microsoft Office.exe” installation file.
3. Click Install to start the installation process.
4. Accept the License Agreement and click Install.

Note: if you only want to install individual modules of Secure Connector, see section 2.4.2. for Advanced
Installation Options, page 8.

5. Once the installation is complete click Finish to exit the Installation Wizard.
6. Finally, click Close.

Secure Connector for Microsoft Office is installed on the respective client computer. Proceed to section 3.1 
Configure Data Room Servers, page 16.
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2.4.2. INSTALLATION USING ADVANCED INSTALLATION OPTIONS

If required, you can only install individual modules of Secure Connector for Microsoft 
Office.
1. Close all Microsoft Office programs.
2. Double-click the “Secure Connector for Microsoft Office.exe” installation file.

The welcome screen of the Installation Wizard for Secure Connector for Microsoft Office is displayed.
3. Click Install to start the installation process.

4. Accept the License Agreement and click the Advanced button.

5. Accept the default destination folder, or change to the desired folder and then click Next.

6. In the Product Features dialog, select the features you want to install by clicking on the down arrow.

7. By default, all features are activated in the Product Features dialog. If you want to exclude one or more

of the available Secure Connector features, however, deselect the feature by selecting the Entire feature

will be unavailable option from the corresponding drop-down list:

Important note: Do not select the options Entire feature will be installed on local hard drive or
Feature will be installed when required.

8. Click Install and the selected Secure Connector features are now being installed on the given computer.

9. Once the installation is complete click Finish to exit the Installation Wizard.
10. Finally, click Close.

Secure Connector for Microsoft Office is now installed on the respective client computer. 
Proceed to section 3.1 Configure Data Room Servers, page 16.
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3. Configure Secure Connector for Microsoft
 Outlook

Secure Connector for Microsoft Outlook is installed with certain default settings, like upload and download 
behavior for documents, attachment handling and sync settings for Data Room collaboration items. These 
default settings can be adjusted by the system administrator and the user at any time. Read the following 
sections for details on how to customize these settings. 

3.1. CONFIGURE DATA ROOM SERVERS

After the installation of Secure Connector open Microsoft Outlook to configure the connections to the 
servers on which your Data Rooms are installed.

1. Open Microsoft Outlook.
A Welcome to email is displayed which leads you through the first configuration steps required.

2. Click the Configure Servers button to the right of this email.
The Configure Servers dialog window is displayed.

3. Open the Server URL drop-down list, and select a Data Room server, or type the server’s
URL into the field.

Note: The most common Data Room servers (.NET, .US and .CH) can be selected from the list; other URLs 
must be entered manually into the field. 

a) To authenticate with your email address and password:
In the Username & Password tab, enter your Username (your email address you defined
during your first registration to the Data Room server) and your Password.

b) To authenticate with your Data Room certificate: 
Open the Certificate tab. Click the Select Certificate button, and select the appropriate
certificate from the list. Certificate details are then shown in the respective fields.

c) To authenticate with your SAML login:
Open the SAML tab. Enter your Username (your email address you defined during your
first registration to the Data Room server).

4. Click OK to save your settings.
Once the connection to the given Data Room server has been established a corresponding message
is displayed.

5. Click OK to confirm this message.
The Change Settings dialog window is displayed with the Servers pane open by default.

6. You can Add Data Room Servers, see page 21, or adjust the general settings for Secure
Connector, see pages 17ff.

7. Click OK to close this dialog window.
Back in the Welcome email, you see a list of your Data Rooms in the Browse tab.
You can now adjust the default language, email settings, upload and download behavior,
attachment handling and collaboration settings to your needs.
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3.2. ADJUST THE GENERAL SETTINGS FOR SECURE CONNECTOR FOR MICROSOFT 
OUTLOOK

To customize the default language, email settings, and document upload and download behavior to your 
needs:

1. Open Microsoft Outlook.
2. Open the Home tab.
3. Click the Data Room button and select Settings.

The Change Settings dialog window is displayed with the General pane open by default.
4. Proceed to the next section to adjust the email options to your needs.

3.2.1. ADJUST THE LANGUAGE SETTING

In the Change Settings dialog window, verify and if necessary adjust the user interface Language to your 
needs.

1. Open the Language drop-down list and choose your preferred language, i.e. English, German,
French, Italian, Portuguese, or Spanish.

2. Click OK.
3. Exit and restart Microsoft Outlook for the new language to take effect.

3.2.2. ADJUST THE EMAIL OPTIONS

In the Change Settings dialog window, verify and if necessary adjust the following email options to your 
needs.

1. Use the Data Room’s email security settings as the default:
This option is activated by default to ensure that document links attached to an email are sent in
accordance with the Data Room’s security setting, i.e. the Email Encryption setting. Every email
is additionally  sent as a Protected Message.
If you do not want to use this function, deactivate it. Users can then decide individually for each
email whether they want to protect it or not.

2. Prefer the “Maximum (Data Room members)” security level when sending emails to Data
Room members:
This option is activated by default to ensure that emails with document links sent to Data
room members are sent using the highest security level, i.e. Maximum (Data Room
members). This security level is then automatically selected in the Security Options tab.
If you do not want to use this function, deactivate it. Users can then decide individually, and
in accordance with the Data Room’s settings which security level they want to use.

3. Always show the Secure Mail Assistant when creating a new email
This option is deactivated by default. Activate this option, if you want the Secure Mail Assistant pane
to be displayed every time you create a new email.

4. Convert email format from plain text to HTML and add signature:
This option is activated by default to ensure that emails sent through a program other than
Microsoft Outlook, e.g. through the Windows Explorers Send to Mail Recipient option, are switched
from text only to HTML, and have the users default signature added.
If you do not want to use this function by default, deactivate it.
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3.2.3. ADJUST THE PROTECTED MESSAGE OPTIONS

In the Change Settings dialog window, verify and if necessary adjust the following option to your needs. In 
the Change Settings dialog window, verify and if necessary adjust the following option to your needs.

1. Transfer protected messages to this Data Room:
Click Browse to define the Data Room into which protected messages are to be transferred.  
If you do not define a Data Room here, users are asked to select a Data Room when they
send a protected message the first time. Afterwards that Data Room is saved as the default 
Data Room and can be changed in the Security Options.

3.2.4. ADJUST THE DOCUMENT UPLOAD OPTIONS

In the Change Settings dialog window, verify and if necessary adjust the following upload option to your 
needs.

1. Prevent upload of duplicates:
This option is activated by default to ensure that no document duplicates are uploaded to a
Data Room. If you do not want to use this function, deactivate it.

3.2.5. ADJUST THE DOCUMENT DOWNLOAD OPTIONS

In the Change Settings dialog window, verify and if necessary adjust the following download options to your 
needs.

1. Save file in temp folder:
This option is activated by default. With this option, each downloaded document is saved to the
system’s Temp directory (C:\Users\PC\AppData\Local\Temp).

2. Ask me where to save each file before downloading:
Activate this option, if a user should be asked to specify a download location each time they
download a document from a Data Room.

3. Save file to:
Activate this option and click Browse to define the file path to which each downloaded document is
saved to.

3.2.6. ADJUST THE DEBUG OPTIONS / SEND A LOG FILE TO SUPPORT

From the Change Settings dialog window, you can send a log file to a predefined email address. 
If you want to report a problem or an error that occurred within Secure Connector, click the Send Log File 
button. Debug information is sent to the support email address defined in the respective 
brainloopoffice.sdf settings file. Confirm the displayed message by clicking OK.

TIP: If you have a problem with the operation of Secure Connector, activate the Detailed log file option 
and click OK. This activates verbose logging, which ensures that every detail is logged and stored in the log 
file. Next, repeat the previous steps. When you are done, go back to the General Settings and click the
Send Log File Button.
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3.2.6.1. LOCATE OTHER LOG FILES FOR SUPPORT

If there is a recurring problem with the operation of Secure Connector, you may need to send more than 
today’s log file to support.  

The regular log files are located in the user’s local App directory. Access to this directory is
 available quickly from C: using the %LocalAppData% environmental variable. 

For instance:

C:\Users\{USERNAME}\AppData\Local\Brainloop\BSC\Logs (English and Default) 
C:\Benutzer\{USERNAME}\AppData\Local\Brainloop\BSC\Logs (Example with German OS 
Each session (i.e. start of an office application) creates a separate log file using the following format: 
{OfficeApplication} {yyyy-MM-dd} {HHmmss} #{number).log  
I.e. product name + date (in year-month-day + time in (HoursMinutesSeconds + #sequential number.log
For instance: 
Outlook 2017-07-05 185901 #001.log

The sequential number starts with 001. If a log file that records the session reaches the maximum number of 
permitted lines, a new log file numbered sequentially is created (i.e. 001, 002, etc.).

3.3. ADJUST THE ATTACHMENT HANDLING SETTINGS FOR SECURE CONNECTOR 

To customize the default attachment handling settings when sending emails to your needs:

1. Open Microsoft Outlook.
2. Open the Home tab.
3. Click the Data Room button and select Settings.

The Change Settings dialog window is displayed
4. Click the Attachments tab.
5. This opens the Attachments pane, where you can adjust the attachment handling settings to your

needs.

3.3.1. ADJUST THE SETTINGS TO CONVERT ATTACHMENTS INTO LINKS 

In the Change Settings dialog window, verify and if necessary adjust the following settings to convert email 
attachments into links to your needs.

1. Convert email attachments into links – On email send:
This option is activated by default to ensure that a user can define their preferred attachment
stripping options in the Add Attachments dialog window when adding an attachment from outside
Microsoft Outlook, e.g. from Windows Explorer to an email.
If you do not want to use this function, deactivate it.

2. Convert email attachments into links – On send from other Secure Connector applications:
This option is activated by default to ensure that an attachment is inserted as a secure link
automatically when being sent from another Secure Connector application, like Microsoft
Excel, for example.
If you do not want to use this function, deactivate it.
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3. Convert email attachments into links – On attachment add:
This option is activated by default to ensure that a user can define their preferred attachment
stripping options in the Add Attachments dialog window when adding an attachment to an email via
Copy and Paste.
If you do not want to use this function, deactivate it.

3.3.2. ADJUST THE AUTO-UPLOAD AND LINK INSERTION SETTING 

In the Change Settings dialog window, verify and if necessary adjust the following auto-upload and link 
insertion setting to your needs.

1. Auto-upload documents and insert links:
This option is deactivated by default to ensure that a user can define their preferred Data Room
folder in the Add Attachments dialog window each time they add a local document to an email.
Activate this option if you want to upload each document added to an email to the last-used Data
Room folder and to insert a document link in the email at the cursor position automatically.

3.4. ADJUST THE SERVER SETTINGS FOR SECURE CONNECTOR FOR MICROSOFT 
OUTLOOK

To add further Data Room servers, change or remove existing ones, and to set certain proxy server options 
for Secure Connector:

1. Open Microsoft Outlook
2. Open the Home tab.
3. Click the Data Room button and select Settings.

The Change Settings dialog window is displayed.
4. Click the Servers tab.
5. Proceed to the next sections to adjust the server settings to your needs.

3.4.1. ADD DATA ROOM SERVERS

In the Change Settings dialog window, add further Data Room servers to be available in Secure Connector 
for Microsoft Windows.

1. In the Servers section, click Add.
The Configure Server dialog window is displayed.

2. To add a Data Room server, proceed to section 3 Configure Secure Connector for
Microsoft Outlook, page 16.

3. Click OK to save your settings.
Once the connection to the given Data Room has been established a corresponding message is
displayed.

4. Confirm this message by clicking OK.
5. Click OK to close the Change Settings dialog window.
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3.4.2. CHANGE DATA ROOM SERVERS

In the Change Settings dialog window, change the existing Data Room servers to be available in Secure 
Connector for Microsoft Windows.

1. Select a server from the Servers list.
2. Click Change.
3. Make your changes in the Configure Servers dialog window as described in section 3 Configure

Secure Connector for Microsoft Outlook, page 16.
4. Click OK to save your settings.
5. Click OK to close the Change Settings dialog window.

3.4.3. REMOVE DATA ROOM SERVERS

In the Change Settings dialog window, remove those Data Room servers that are no longer needed in 
Secure Connector for Microsoft Windows.

1. Select a server from the Servers list.
2. Click Remove.

The selected server is removed from the list of configured servers immediately.
3. Click OK to close the Change Settings dialog window.

3.4.4. ADJUST THE PROXY SERVER SETTINGS

In the Change Settings dialog window, verify and, if necessary, adjust the default proxy server settings 
to your needs. 

1. No proxy server:
Activate this option, if you do not want to access the Data Room server via a proxy server.

2. Use system proxy settings:
Activate this option, if you want to access the Data Room server via a proxy server as configured in
your local Internet Explorer. Depending on the configuration, you may be prompted for a username
and password to connect with the proxy server.

3. Use manual proxy settings:
Activate this option, if you want to define a different proxy server than the one that is already
configured in your system. To do so, enter the address and port of the proxy server in the
corresponding fields.
Proxy authentication required?
Activate this option, if an authentication is required to connect with the proxy server and enter the
corresponding username and password.
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3.5. ADJUST THE SYNC SETTINGS FOR COLLABORATION ITEMS FOR SECURE 
CONNECTOR

To customize the default sync settings for Data Room collaboration items, i.e. Data Room calendar events 
and tasks to your needs: 

1. Open Microsoft Outlook.
2. Open the Home tab.
3. Click the Data Room button and select Settings.

The Change Settings dialog window is displayed.
4. Click the Collaboration tab.
5. Proceed to the next sections to adjust the sync settings for Data Room collaboration items to your

needs.

3.5.1 ADJUST THE SYNC SETTINGS FOR DATA ROOM COLLABORATION ITEMS

In the Change Settings dialog window, verify and if necessary adjust the following sync settings for 
collaboration items to your needs.

1. Synchronize every n minutes:
The default time period after which calendar events and tasks are retrieved from a Data Room
server  and synced with Microsoft Outlook is set to 20 minutes. If you want to change this time
period overwrite the default value with your own, or use the Arrow Up or Down buttons.

2. Synchronize period (n days):
The default time period within which calendar events and tasks are retrieved from a Data Room is
set to 30 days. If you want to change this time period overwrite the default value with your own,
or use the Arrow Up or Down buttons. Once the specified period has expired, collaboration items
from the Data Room server are no longer synced with Microsoft Outlook.

3. Only synchronize Data Rooms I have visited:
This option is activated by default to ensure that only collaboration items of Data Rooms that you
have visited are synced with Microsoft Outlook.
If you do not want to use this function by default, deactivate it.

3.5.2 ADJUST THE SYNC SETTINGS FOR DATA ROOM CALENDAR EVENTS

In the Change Settings dialog window, verify and if necessary adjust the following sync settings for 
Data Room calendar events to your needs.

1. Display all Data Room events in Outlook:
Activate this option to ensure that events from the Data Room calendar are synced with the
Microsoft Outlook calendar. If you do not want to use this function leave it deactivated.

2. Only display my events:
Activate this option to ensure that only your Data Room calendar events are synced with Microsoft
Outlook. If you do not want to use this function, deactivate it.
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3.5.3. ADJUST THE SYNC SETTINGS FOR DATA ROOM TASKS

In the Change Settings dialog window, verify and if necessary adjust the following sync settings for Data 
Room tasks to your needs.

1. Display all Data Room tasks in Outlook:
Activate this option to ensure that tasks from the Data Room are synced with the Microsoft Outlook
tasks. If you do not want to use this function, leave it deactivated.

2. Only display my tasks:
Activate this option to ensure that only your Data Room tasks are synced with Microsoft Outlook.
If you do not want to use this function, deactivate it.

3.6. CHECK FOR UPDATES

3.6.1. AUTOMATIC UPDATE OF SECURE CONNECTOR FOR MICROSOFT OUTLOOK

Secure Connector for Microsoft Office is configured such that it automatically checks for updates every 
seven days by default.

CAUTION: Please note that an update of Secure Connector for Microsoft Office requires local administrator 
rights on the respective client computer. If users do not have administrator rights on the client computers, 
make sure you deactivate the “Automatically check for updates every n days” option.

3.6.1.1. ADJUST THE AUTOMATIC UPDATE SETTINGS

1. Open Microsoft Outlook
2. Open the Home tab.
3. Click the Data Room and select Settings

The Change Settings dialog window is displayed.
4. Click the About tab.
5. In the Change Settings dialog window, verify and if necessary adjust the Automatically check for

updates every n days option to your needs,
• This option is activated by default. The default time period after which Secure Connector

automatically checks for an update is set to 7 days. If you want to change this time period
overwrite the default value with your own, or use the Arrow Up or Down buttons.

• If you do not want to use this auto-update function or if users do not administrator rights on
the client computers deactivate it.

6. Click OK to close this dialog window.

3.6.2. MANUAL UPDATE OF SECURE CONNECTOR MICROSOFT OUTLOOK

1. Open Microsoft Outlook.
2. Open the Home tab.
3. Click the Data Room button and select Settings.

The Change Settings dialog window is displayed.
4. Click the About tab.
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4. Click the Check for Updates Now button.
If updates are available, the Software Update window is displayed.
The Change Log browser contains the changes that were made to the last versions of Secure
Connector. To update to the latest version, click Update and follow the instructions in the
update wizard.

5. To skip the latest version, click Skip this version.
6. If no updates are available, confirm the displayed message by clicking OK.
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4. Configure Secure Connector for Microsoft Excel,
Word or PowerPoint
Secure Connector for Microsoft Excel, Word, and PowerPoint is installed with certain default settings, like 
download behavior for documents. These default settings can be adjusted by the system administrator and 
the user at any time. Read the following sections for details on how to customize these settings.

4.1. CONFIGURE DATA ROOM SERVERS

If you have already configured your Data Room servers in the Secure Connector for Microsoft Outlook, 
these servers are also available in the other Microsoft Office applications installed on your computer. If you 
have not configured any Data Room servers at all, proceed as follows:

1. Open Microsoft Excel, Word, or PowerPoint
2. In the Home tab, click the Data Room button and select Settings.

The Change Settings dialog window is displayed.
3. Click the Servers tab.
4. Proceed as described in section 3.1 Configure Data Room Servers, page 16.

4.2. ADJUST THE GENERAL SETTINGS FOR SECURE CONNECTOR

To customize the default download behavior settings for Microsoft Excel, Word, or Powerpoint 
documents 
to your needs:
1. Open Microsoft Excel, Word, or PowerPoint.
2. Open the Home tab.
3. Click the Data Room button and select Settings.

The Change Settings dialog window is displayed with the General pane open by default.
4. Proceed to the next section to adjust the settings to your needs.

4.2.1. ADJUST THE DOWNLOAD OPTIONS FOR EXCEL, WORD, OR POWERPOINT 
DOCUMENTS

In the Change Settings dialog window, verify and if necessary adjust the following download options for 
Excel, Word, or PowerPoint documents to your needs.

1. Save file in temp folder (delete file on close):
This option is activated by default. With this option, each downloaded Microsoft Office document is
saved to the system’s Temp directory (C:\Users\PC\AppData\Local\Temp). When the document is
closed it is removed from the Temp directory.

2. Ask me where to save each file before downloading:
Activate this option if a user should be asked to specify a download location each time they
download a Microsoft Office document from a Data Room.
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3. Save file to:
Activate this option and click Browse to define the file path to which each downloaded Microsoft
Office document is saved to.

4. Embed Data Room information in documents:
This option is activated by default. With this option, information from the Data Room is embedded in
the document’s properties.

4.3. CHECK FOR UPDATES

4.3.1. AUTOMATIC UPDATE OF SECURE CONNECTOR

Secure Connector for Microsoft Excel, Word, or PowerPoint is configured such that it automatically checks 
for updates every seven days by default.  

CAUTION: Please note that an update of Secure Connector for Microsoft Office requires local administrator 
rights on the respective client computer. If users do not have administrator rights on the client computers, 
make sure you deactivate the “Automatically check for updates every n days” option.

4.3.1.1. ADJUST THE AUTOMATIC UPDATE SETTINGS

1. Open Microsoft Excel, Word, or PowerPoint
2. Open the Home tab.
3. Click the Data Room button and select Settings.

The Change Settings dialog window is displayed.
4. Click the About tab.
5. In the Change Settings dialog window, verify and if necessary adjust the Automatically check for

updates every n days option to your needs.
• This option is activated by default. The default time period after which Secure Connector

automatically checks for an update is set to 7 days. If you want to change this time
period overwrite the default value with your own, or use the Arrow Up or Down buttons.

• If you do not want to use this auto-update function or if a user has no administrator right
on their client computer deactivate it.

6. Click OK to close this dialog window.

4.3.2. MANUAL UPDATE OF SECURE CONNECTOR

CAUTION: Please note that an update of Secure Connector for Microsoft Excel, Word, Outlook or 
Power-
Point requires local administrator rights on the respective client computer.

1. Open Microsoft Excel, Word, or PowerPoint
2. Open the Home tab.
3. Click the Data Room button and select Settings.

The Change Settings dialog window is displayed.
4. Click the About tab.
5. Click the Check for Updates Now button.
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6. If updates are available, the Software Update window is displayed.
• The Change Log browser contains the changes that were made to the last versions of

Secure Connector. Please note that this information is currently available in English only.
• To update to the latest version, click Update and follow the instructions in the update wizard.
• To skip the latest version, click Skip this version.

7. If no updates are available, confirm the displayed message by clicking OK.
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5. Frequently Asked Questions
5.1. WHAT IS CONTAINED IN THE INSTALLATION PACKAGE 

The installation package (*.exe) contains the following software components:
• Secure Connector for Microsoft Office
• Microsoft .Net 4.5.2 Framework (web installer; an Internet connection is required during the

installation)
• Microsoft Visual Studio 2010 Tools for Office Runtime (x86) for 32-bit systems
• Microsoft Visual Studio 2010 Tools for Office Runtime (x64) for 64-bit systems
• Microsoft Visual C++ 2012 Redistributable (x86) â€“ 11.0.610.30
• Microsoft Visual C++ 2012 Redistributable (x64) – 11.0.610.30

5.2. WHAT DO I DO IF THE INSTALLATION HAS FAILED FOR SOME REASON?

If for some reason the installation of Secure Connector has failed, you can help us in troubleshooting 
the issue by providing us with the corresponding installation log files. 
These installation logs are stored in the user ’s Temp directory. Access to this directory is available 
quickly from C: using the %temp% environmental variable. 
The following log files should be available: 
> The log from the bootstrapper, i.e. the application which manages the installation chain:

Brainloop_Secure_Connector_for_Microsoft_Office_YYYYMMDDhhmmss.log
> The log (if any) from the Microsoft Visual Studio Tools for Office installation:

Brainloop_Secure_Connector_for_Microsoft_Office_YYYYMMDDhhmmss_vstor40_x86.exe.log
The log from the Brainloop Secure Connector installation:
Brainloop_Secure_Connector_for_Microsoft_Office_YYYYMMDDhhmmss_BrainloopOfficeSuite_Pac
kage.log

5.3. WHAT CAN I DO IF SECURE CONNECTOR FOR MICROSOFT OFFICE IS 
DEACTIVATED ACCIDENTALLY OR DOES NOT SHOW UP AFTER THE 
INSTALLATION?

Under certain rare circumstances, Secure Connector for Microsoft Office may become deactivated or dis-
appear and remain so even after restarting Microsoft Outlook. If this occurs, please proceed as follows in 

Microsoft Outlook 2010:

1. Open the File tab and select Options.
2. Click Add-Ins to open the View and manage Microsoft Add-Ins window.
3. Open the Manage drop-down list and select COM Add-ins.
4. Click Go.
5. In the COM Add-ins window, make sure that Secure Connector for Microsoft Office is activated.
6. If the add-in is deactivated, activate it with your mouse.
7. Click OK to save your changes.
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If the add-in is still not available, double-check that it is not disabled.

1. In Microsoft Outlook, open the File tab and select Options.
2. Click Add-Ins to open the View and manage Microsoft Add-Ins window.
3. Open the Manage drop-down list and select Disabled Items.
4. Click Go.
5. If Secure Connector for Microsoft Office is listed in this window, select the item and click

Enable.
6. Finally, activate the add-in by checking the checkbox as described above.

5.4. AVG VIRUS PROTECTION PREVENTS INSTALLATION AND REPORTS AN 
“IDENTITY PROTECTION” PROBLEM. HOW CAN I STILL INSTALL?

According to AVG the bundle installer is identified as a problem as it hits their “installs other programs” 
behavior check.  

To work around this problem, a manual installation of the prerequisites can be performed. .

5.5. SECURE CONNECTOR DOES NOT INSTALL WITH MICROSOFT OFFICE 2007

With older Microsoft Office products, such as Microsoft Office 2007, problems might occur during
installation of Secure Connector. Please note that Secure Connector requires Microsoft Office 2007 SP3.
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